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Welcome to WinSteam 4.0 from 
Techware Engineering Applications, Inc. 

WinSteam Version 4.0 provides accurate steam property functions which can be accessed through DeskTop 
Steam, our interactive steam property calculator, and can be called by many Windows applications including 
Microsoft Excel, Lotus 1-2-3, and MathSoft Mathcad.  Programmers can call the steam functions from 
programming languages such as Visual BASIC, Visual C++ and many databases.  The software supports 32-bit 
and 64-bit versions of most applications and can run under Windows NT, 2000, XP, Vista, Windows 7 or 
Windows 8.   
 
 

System Requirements 
 

The minimum system requirements needed to use WinSteam Version 4.0 include: 

• Microsoft Windows NT, 2000, XP, Vista, Windows 7 or Windows 8.  
• All other hardware required by your version of Microsoft Windows.  
• Approximately 2.4 MB of free disk space 

 
Multi-User Licenses 

 
If your WinSteam license allows more than one concurrent user, then you may repeat the installation on as many 
computers as indicated on your license.  In each installation, you will use the same serial and authorization 
numbers. 
 

Preparing for Installation 
 

Locate Your Serial and Authorization Numbers 
You will find your serial number and authorization number on the license document we sent you with your 
purchase.  You will be asked for these numbers during the installation process.  These are your unique 
numbers.  Be sure to store them in a safe and secure place. 
 
If someone else wishes to try WinSteam on his computer, do not give him your numbers.  You are 
responsible for keeping these numbers private.  Instruct them to visit our website where they can download a 
copy for a 30 day evaluation. 
 
If you are installing WinSteam as a demo you will not need a serial number, however, if you try to install 
WinSteam as a demo after the evaluation period has expired, you will be prompted for a demo number.  If 
you require a second evaluation period, call Techware. 

 
Log On with Administrator Privileges 

If your computer is running Windows NT, 2000, XP, Vista, Windows 7 or Windows 8, you must be logged in 
with Administrator privileges for a complete installation. 

 
Decide Whether You Need to Support 32-bit Applications, 64-bit Applications or Both 

WinSteam 4.0 has separate 32-bit and 64-bit installation programs.  If your computer is running a 64-bit 
operating system, such as Windows 7, you may install either the 32-bit or 64-bit versions of WinSteam, 
depending upon the applications you wish to support.  For example, if you have installed the 64-bit version of 
Office 2010 or later, you should install the 64-bit version of WinSteam.  This will provide the proper WinSteam 
Add-in for Excel and install the 64-bit version of the DeskTop Steam calculator.  If, however, you have a 32-bit 
operating system or have installed an earlier version of Office or the 32-bit version of Office 2010 or later, you 
only need to install the 32-bit version of WinSteam.  This will give you the proper WinSteam Add-in for Excel 
and the 32-bit version of the DeskTop Steam calculator, which is functionally identical to the 64-bit version. 
 



If you are not sure whether you have the 32-bit or 64-bit version of Excel 2010 installed, open Excel, click the 
‘File’ menu then click the ‘Help’ item near the bottom of the menu.  On the right side of the page just below 
“About Microsoft Excel” you will see a version number followed by either (32-bit) or (64-bit).  That tells you 
which version of Excel you are running. 
 
If you are not sure whether you have the 32-bit or 64-bit version of Excel 2013 installed, open Excel, click the 
‘File’ menu then click the ‘Account’ item near the bottom of the menu.  On the right side of the page click the 
‘About Excel’ button.  On the first line of the “About Microsoft Excel” dialog box, you will see a version number 
followed by either (32-bit) or (64-bit).  That tells you which version of Excel you are running. 
 
If you installed the 64-bit version of WinSteam and also wish to support some 32-bit applications, such as 
MathCad or 1-2-3, you may also install the 32-bit version of WinSteam to support those applications.  Since 
Windows 7 segregates 32-bit and 64-bit programs and operations, you will have to enter your same license 
data for both versions. 

 
Install Other Applications before WinSteam 

If you wish to use WinSteam with Excel, 1-2-3 or Mathcad, make sure these applications are installed before 
installing WinSteam.  The Setup program will copy add-in files to specific directories of these applications so 
that they can find the WinSteam add-ins.  If you upgrade any of these applications after installing WinSteam, 
you may have to re-install WinSteam for proper operation. 
 



Step-by-Step Installing WinSteam (32-bit) 
 

1. If you have already installed WinSteam as a demo, you do not need to reinstall the software.  Just go to the 
"TechwareEng/WinSteam" program group and click "Register WinSteam" (If you are running Windows Vista 
or later, right click on "Register WinSteam” and select “Run as Administrator”.)  Skip ahead to Step 9. 

2. If you have any version of WinSteam 3 installed, go to the Windows Control Panel and uninstall WinSteam. 

3. Download the WinSteam software from our website at http://www.techwareeng.com/DlWS40.html  Open 
Windows Explorer, and find the WinSteam file that you downloaded from our website.  Double click the file 
“WinSteam40x86.exe” to begin the installation. 

4. In the Welcome dialog box, press 'Next' 

5. In the Software License Agreement dialog box, select “I agree…” and press 'Next'. 

6. In the Choose Destination Location dialog box, press ‘Next’ to accept the default location.  Press ‘Browse’ 
to select an alternate location then press ‘OK’ and then ‘Next’ to continue. 

7. In the Shortcut Folder dialog box, press ‘Next’ to accept the default location for shortcuts.  You may change 
the shortcut location or make the shortcuts visible only to the current user if you wish. 

8. In the Select Components dialog box, DeskTop Steam, the add-in for Excel and Programming Support will 
be checked.  If you wish to install add-ins for 1-2-3 and MathCad, you should check these boxes. If these 
applications are installed on your computer, the add-ins will be installed to a location where they will be found 
automatically by the applications.  If not, they will be installed to the WinSteam program folder from where you 
can move them later.  If you are not planning to use the functions with C++ or Visual Basic programming, you 
may uncheck the “Programming Support” box to save some disk space.  Press ‘Next’ to continue. 

9. In the Question dialog box, press ‘No’ if you will be using old Excel spreadsheets containing WinSteam 
functions.  Press ‘Yes’ if you are a new user.  If you press ‘Yes’, you must include the unit set argument with 
each function call. 

10. In the Ready To Install dialog box, press ‘Next’ to proceed. 

11. In the Product License Verification dialog box, press the “Enter License Numbers” button if you have your 
Serial and Authorization numbers; enter them then press ‘OK’ and then ‘Done’.  If you are installing WinSteam 
as a demo, press the ‘Demo’ button.  You should receive a notice that you have 30 days to evaluate the 
software. 

12. Press ‘Finish’ to complete the installation. 

http://www.techwareeng.com/DlWS40.html


Step-by-Step Installing WinSteam (64-bit) 
 

1. If you have already installed WinSteam as a demo, you do not need to reinstall the software.  Just go to the 
"TechwareEng/WinSteam (x64)" program group and right click on "Register WinSteam” and select “Run as 
Administrator”.  Skip ahead to Step 9. 

2. Download the WinSteam software from our website at http://www.techwareeng.com/DlWS40.html  Open 
Windows Explorer, and find the WinSteam file that you downloaded from our website.  Double click the file 
“WinSteam40x64.exe” to begin the installation. 

3. In the Welcome dialog box, press 'Next' 

4. In the Software License Agreement dialog box, select “I agree…” and press 'Next'. 

5. In the Choose Destination Location dialog box, press ‘Next’ to accept the default location.  Press ‘Browse’ 
to select an alternate location then press ‘OK’ and then ‘Next’ to continue. 

6. In the Shortcut Folder dialog box, press ‘Next’ to accept the default location for shortcuts.  You may change 
the shortcut location or make the shortcuts visible only to the current user if you wish. 

7. In the Select Components dialog box, DeskTop Steam, the add-in for Excel and Programming Support will 
be checked.  If you are not planning to use the functions with C++ or Visual Basic programming, you may 
uncheck the “Programming Support” box to save some disk space.  Press ‘Next’ to continue. 

8. In the Question dialog box, press ‘No’ if you will be using old Excel spreadsheets containing WinSteam 
functions.  Press ‘Yes’ if you are a new user.  If you press ‘Yes’, you must include the unit set argument with 
each function call. 

9. In the Ready To Install dialog box, press ‘Next’ to proceed. 

10. In the Product License Verification dialog box, press the “Enter License Numbers” button if you have your 
Serial and Authorization numbers; enter them then press ‘OK’ and then ‘Done’.  If you are installing WinSteam 
as a demo, press the ‘Demo’ button.  You should receive a notice that you have 30 days to evaluate the 
software. 

11. Press ‘Finish’ to complete the installation. 

http://www.techwareeng.com/DlWS40.html


 
Getting Started 

 
Using the DeskTop Steam Calculator 

DeskTop Steam is a Windows program that calculates the thermodynamic and transport properties of steam and 
water.  It calculates all unknown properties when a state point is defined by two known properties.  DeskTop 
Steam allows you to label and store a collection of state points, which can be printed in a table or copied to the 
clipboard and pasted into other Windows applications. 

You can launch DeskTop Steam by clicking the Windows ‘Start’ button then go to ‘All Programs’, ‘TechwareEng’ 
folder, ‘WinSteam’ folder and click “DeskTop Steam’. 

Once you have started DeskTop Steam, you can get specific instructions for using it from the Help Menu.  We 
suggest that you start by clicking “DeskTop Steam Topics” on the Help ‘Contents’ tab and review the topics in 
order. 

You can find operating instructions for DeskTop Steam in Chapter 3 of the User’s Manual as well. 

 
Loading the WinSteam Functions into Excel (32-bit) 

The WinSteam add-in for Excel is launched from within Excel.  Once you have started Excel, use the Tools, Add-
ins menu to start Excel’s Add-In Manager.   (In Office 2007, click the Office button, then click the “Excel Options” 
button, then select the Add-ins tab and click the “Go…” button at the bottom. In Office 2010 or 2013, you can get 
to the Add-ins tab by clicking the File menu and then the Options item.)   In the list box you should see an item 
“WinSteam for Excel” or “WinSteam for Excel 2007” if you are running Office 2007 or later.  If you did not find 
either item in the Add-in Manager list box, click the ‘Browse’ button and look for the file XLStm32.xll.  It should be 
in the C:\Program Files\TechwareEng\WinSteam directory.  When you find it, click OK.  “WinSteam for Excel” or 
“WinSteam for Excel 2007” should now appear in the list box.  If you are running Windows 7 or 8, look in the 
C:\Program Files (x86)\ TechwareEng\WinSteam directory for the file. 

Click the check box next to “WinSteam for Excel” and press ‘OK’.  The WinSteam copyright notice should be 
displayed on the status bar at the bottom of Excel.  The WinSteam add-in is now loaded into Excel and will reload 
every time you start Excel.  If you do not want the Add-in to load each time you start Excel, go back to the Add-in 
Manager and uncheck the WinSteam box before closing Excel. 

 

Loading the WinSteam Functions into Excel (64-bit) 
The WinSteam add-in for Excel is launched from within Excel.  Once you have started Excel, click the File menu 
and then the Options item, then select the Add-ins tab and click the “Go…” button at the bottom.   Click the 
‘Browse’ button and look for the file XLStm64.xll.  It should be in the C:\Program Files\TechwareEng\WinSteam 
directory. When you find it, click OK.  “WinSteam for Excel” should now appear in the list box. 

Click the check box next to “WinSteam for Excel 2010” and press ‘OK’.  The WinSteam copyright notice should 
be displayed on the status bar at the bottom of Excel.  The WinSteam add-in is now loaded into Excel and will 
reload every time you start Excel.  If you do not want the Add-in to load each time you start Excel, go back to the 
Add-in Manager and uncheck the WinSteam box before closing Excel. 

 

Using the WinSteam Functions from Excel 
Once the add-in is loaded, you can use the steam property functions in the same way as you would use Excel’s 
built-in functions.  That is, you can type the function in a cell formula or use the Insert Function menu to guide 
you. 

If you use the Insert Function menu, select the “Engineering” category and choose one of the functions beginning 
with “Stm”. (In Office 2007, Insert Function is on the “Formulas” tab.)  If you have other Techware add-ins 
installed, you will see those functions as well.  As you click on a function, you will see its description below the list 



box.  When you find the function that you want, click ‘OK’ and the next dialog box will guide you through the 
selection of each function argument.  

You can find more detailed information by clicking “WinSteam Help for Excel Add-in” or “WinSteam User’s 
manual” in the “TechwareEng\WinSteam” program group.  A sample file is included in the “Program 
Files/TechwareEng/WinSteam/Samples” directory. 
 

Using the WinSteam Functions from 1-2-3 
The WinSteam add-in for 1-2-3 is launched from within 1-2-3.  Since 1-2-3 is a 32-bit program, it is only 
supported by the 32-bit version of WinSteam.  Once you have started 1-2-3, use the File, Add-Ins, Manage Add-
ins menu selections to start the Add-In manager.  Before you can use the WinSteam add-in for the first time, you 
must register it by pressing the 'Register' button.  You should see the file afsteam.12A in the Register Add-Ins 
window.  If you installed the file elsewhere, you will have to use the 'Look in' window to search for the file.  When 
you have located the afsteam.12A file, select it and press 'Open'.   The add-in is now registered. 

To load the add-in after it is registered, click on the path name that has the afsteam.12A file.  A check mark will 
appear to the left of the path name indicating that the add-in is selected.  Press 'Done' to complete the task.   

Thereafter, each time you start 1-2-3, the functions will be loaded automatically.  If you wish to unload the 
functions, use the Add-In manager and uncheck the add-in.   

Once the add-in is loaded, the steam property functions can be used in any cell formula by typing the function 
name in the same ways as 1-2-3's built-in functions. 

You can find more detailed information by clicking “WinSteam Help for 123 Add-in” or “WinSteam User’s manual” 
in the “TechwareEng\WinSteam” program group.  A sample file is included in the “Program 
Files/TechwareEng/WinSteam/Samples” directory. 
 
 

Using the WinSteam Functions from Mathcad 
The WinSteam add-in for Mathcad is a self-registering dynamic link library (DLL) named McdStm32.dll.  
WinSteam 4.0 only supports 32-bit versions of MathCad.  The setup program should have installed this file in the 
Mathcadx\userefi directory.  Whenever a WinSteam function is used, Mathcad will automatically load and register 
the function. 

You can use the steam property functions by typing the function with its arguments or by using the Insert Function 
menu. 

If you use the Insert Function menu, select the “Engineering” category and choose one of the functions beginning 
with “Stm”. If you have other Techware add-ins installed, you will see those functions as well.  As you click on a 
function, you will see its description in the box below the list.  When you find the function that you want, click ‘OK’ 
and the function will be inserted in your worksheet with spaces for the arguments.  

You can find more detailed information by clicking “WinSteam User’s manual” in the “TechwareEng\WinSteam” 
program group.  A sample file is included in the “Program Files/TechwareEng/WinSteam/Samples” directory. 
 
 


